
Reading Order tool overview 
The Reading Order tool provides the easiest and quickest way to fix reading order and basic 

tagging problems. When you select the tool, a dialog box opens that lets you see overlay 

highlights that show the order of page content. Each highlighted region is numbered and 

highlighted with gray or colored blocks; the number indicates the region’s placement in the 
page’s reading order. After you check the reading order of the page, you can correct other, 
more subtle tagging issues as needed. 

The Reading Order tool is intended for repairing PDFs that were tagged using Acrobat, not 

for repairing PDFs that were tagged during conversion from an authoring application. 

Whenever possible, return to the source file and add accessibility features in the authoring 

application. Repairing the original file ensures that you don’t have to repeatedly touchup 
future iterations of the PDF in Acrobat. 

You can use the Reading Order tool to perform the following accessibility tasks: 

• Visually check, and then repair, the reading order of page content 

• Tag fillable form fields and their labels 

• Add alternate text to figures and descriptions to form fields 

• Fix the tagging of simple tables, and prepare complex tables for more advanced 
manipulation in the logical structure tree 

• Remove nonessential content, such as ornamental page borders, from the logical 
structure tree 

To perform advanced reading order and tagging tasks, such as fixing complex tables, 

removing obsolete tags, and adding alternate text to links, use the Tags panel. For more 
information, see Edit tags with the Tags panel. 

Tips for using the Reading Order tool 
• Save the document (or a copy of it) before you use the Reading Order tool, as undo-

redo isn't supported for all operations. For more information, see Undo or redo the tag 
changes done using the Reading Order tool. 

• Choose View > Page display > Single-page view from the hamburger menu 

(View menu in macOS), when using the Reading Order tool. When you select the Clear 

Page Structure button, Acrobat clears tags from all visible pages, even pages that are 
only partially visible. 

Select the Reading Order tool 
• Choose All tools > Prepare for accessibility, and then choose Reading Order in the 

left pane. The dialog for the tool is displayed. 

https://helpx.adobe.com/acrobat/using/editing-document-structure-content-tags.html#edit_tags_with_the_tags_panel
https://helpx.adobe.com/acrobat/using/touch-reading-order-tool-pdfs.html#Undo-redo
https://helpx.adobe.com/acrobat/using/touch-reading-order-tool-pdfs.html#Undo-redo


 

Reading Order options 



You can select Reading Order options from the dialog box, from the pop-up menu that 
appears when you right-click a highlighted region, or from the Options menu in the Order 
panel. The Reading Order tool includes the following options: 

LEARN ABOUT THE OPTIONS 

Text/Paragraph 

Tags the selection as text. 

Figure 

Tags the selection as a figure. Text contained within a figure tag is defined as part of the 
image and screen readers don’t read it. 

Form Field 

Tags the selection as a form field. 

Figure/Caption 

Tags a selected figure and caption as a single tag. Any text contained in the tag is defined as a 

caption. Useful for tagging photos and captions and preventing caption text from being 
incorrectly added to adjacent text blocks. Figures may require alternate text. 

Heading 1, Heading 2, Heading 3, Heading 4, Heading 5, Heading 6 

Tags the selection as a first, second, third, fourth, fifth, or sixth level heading tag. You can 
convert heading tags to bookmarks to help users navigate the document. 

Table 

Tags the selection as a table after the selection is analyzed to determine the location of 
headings, columns, and rows. 

Cell 

Tags the selection as a table or header cell. Use this option to merge cells that are incorrectly 
split. 

Formula 

Tags the selection as a formula. Because speech software may handle formula tags differently 

from normal text, you may want to add a description using alternate text. 

Note 

Tags the selection as a note. 

Reference 

Tags the selection as a reference. 



Background/Artifact 

Tags the selection as a background element, or artifact, removing the item from the tag tree. 
That way, it doesn’t appear in the reflowed document and screen readers don’t read it. 

Table Editor 

Automatically analyzes the selected table into cells and applies the appropriate tags. The 
table must be tagged as a table before you can use the Table Editor command on it. 

Show Page Content Groups 

Shows content elements as highlighted areas that contain numbers to indicate the reading 
order. Specify the highlight color by clicking the color swatch. 

Show Table Cells 

Highlights the content of individual table cells. Specify the highlight color by clicking the 
color swatch. 

Display Like Elements In A Single Block 

Adjacent squares with the same tag type are collapsed into a single, bigger square with the 
common tag type that encompasses the original square. 

Show Tables And Figures 

Outlines each table and figure with a crossed-out box. The box also indicates whether the 
element includes alternate text. Specify the box color by clicking the color swatch. 

Clear Page Structure 

Removes the tagging structure from the page. Use this option to start over and create a 
structure if the existing structure contains too many problems. 

Show Order Panel 

Opens the Order tab for reordering highlighted content. 

Edit Alternate Text 

Available in the menu that appears when you right-click a highlighted figure. Allows the user 

to add or edit a text description about the figure properties that a screen reader or other 

assistive technology reads. 

Edit Form Field Text 

Available in the menu that appears when you right-click a form field. Allows the user to add or 
edit a form field text description that a screen reader or other assistive technology reads. 

Edit Table Summary 



Available in the menu that appears when you right-click a highlighted table. Allows the user 
to add or edit a text description about the table properties that a screen reader or other 
assistive technology reads. 

Check and correct reading order (Acrobat Pro) 

You can quickly check the reading order of tagged PDFs by using the Reading Order tool. You 

can also use this tool to add alternate text to images and correct many types of tagging 
problems that are outlined in the report that Acrobat generates when you add tags to a PDF. 

Reading-order problems are readily apparent when you use the Reading Order tool. Each 

section of contiguous page content appears as a separate highlighted region and is 
numbered according to its placement in the reading order. Within each region, text is ordered 

left to right and top to bottom. (You can change this order in the Touch Up preferences.) If a 

single highlighted region contains two columns of text or text that won’t flow normally, divide 

the region into parts that can be reordered. Because highlighted regions are rectangular, they 
may overlap somewhat, especially if their page content is irregularly shaped. Unless page 

content overlaps or is contained within two highlighted regions, no reading order problem is 
indicated. Page content should belong to no more than one highlighted region. 

You can change the reading order of the highlighted regions by moving an item in the Order 

panel. Alternatively, you can drag it on the page in the document pane. By reordering 

highlighted regions on the page, you can make a figure and caption read at the specific point 

that they’re referenced in the text. By changing the order of a highlighted region, you 

effectively change the reading order of that item without changing the actual appearance of 
the PDF. 

Check reading order with the Reading Order tool 
REVIEW THE STEPS FOR CHECKING READING ORDER USING THE TOOL 

1. Select the Reading Order tool in the left pane. 

2. In the Reading Order dialog box, select Show Page Content Groups, and then 
select Page Content Order. 

  

Note:  

If highlighted regions don’t appear in the document pane, the document doesn’t 
contain tags. 

3. Optionally, do any of the following: 

  



• To specify a highlight color, select the color swatch, and then select the 
color you want. 

• To highlight tables and figures, and to view alternate text for figures, 
select Show Tables And Figures. 

4. Check the reading order of text within each highlighted region. 

  

Note:  

Zooming in can make this step easier. 

5. Check the numbered order of all highlighted regions. If consecutive, numbered 

regions don’t follow one another, reorder them in the Order panel. 

6. Select Show Order Panel, and then select each content entry (in brackets [ ]) in the 
Order panel to highlight that content region in the document pane. Use this 
method to find numbered regions that you can’t see or locate on the page. 

Change the reading order in the Order panel 
REVIEW THE STEPS FOR CHANGING THE READING ORDER IN THE ORDER PANEL 

1. Select the Reading Order tool in the left pane. 

2. In the Reading Order dialog, select Show Order Panel. 

3. In the Order panel, navigate to view a list of highlighted regions that appear in the 

document pane. 

4. In the Order panel, drag the tag for a highlighted region to the location you want. As 
you drag, a line appears to show potential locations. After you drag an item to a 

new location, the highlighted regions are renumbered to show the new reading 
order. You can select and move multiple, adjacent regions. 

Change the reading order by dragging on the page 
REVIEW THE STEPS FOR CHANGING THE READING ORDER BY DRAGGING ON THE 
PAGE. 

1. Select the Reading Order tool. 

2. In the Reading Order dialog, select Show Page Content Groups, and then 
select Page Content Order. 

3. In the document pane, place the pointer over the number for the highlighted region 

you want to move. Thenh, drag it to where you want it to be read. The text-insertion 
pointer shows target locations within the text. 

  



When you release the highlighted region, the location of the text-insertion pointer 
becomes the dividing line. The underlying highlighted region is split into two new 

highlighted regions. All highlighted regions are renumbered to show the new 
reading order. 

Edit tags with the Reading Order tool (Acrobat 

Pro) 

You can use the Reading Order tool to create tags in untagged PDFs or to add new tags to an 
existing structure. However, this manual tagging doesn’t provide as much detail to the 

tagging structure as the Add Tags To Document command, such as paragraphs, bulleted and 

numbered lists, line breaks, and hyphens. Before you clear the existing structure, make sure 
that manual tagging is your only recourse. 

REVIEW THE STEPS FOR TAGGING A REGION. 
1. Using the Reading Order tool, drag within the document pane to select a region of 

the page that contains one type of content (for example, a text block). 

2. Do one of the following: 

  

• To add more page content to the current selection, Shift-drag. 

• To remove page content from the current selection, Ctrl-drag. 

3. Click the appropriate button in the Reading Order dialog box to specify the tag 
type. 

Change the tag for a region 

If Acrobat tags a page element incorrectly, you can change the tag type for the highlighted 
region. 

SEE THE STEPS FOR CHANGING THE TAG FOR A REGION. 
1. Select the Reading Order tool in the left pane. 

2. In the Reading Order dialog, select Show Page Content Groups, and then 
select Page Content Order. 

3. To select a highlighted region, do one of the following: 

  

• Drag to select it. 



• Click the number of a highlighted region. 

4. Select the button for the tag type that you want for the highlighted region. 

Add or remove content from a tagged region 

The Reading Order tool always displays as few highlighted regions as possible. If content 

within a highlighted region doesn’t flow properly, you can split a region to reorder it. 

Highlighted regions may also contain adjacent page content that is unrelated or that requires 
a different tag type. Page content may become orphaned from related elements, particularly 

if the content doesn’t fit within a rectangular shape. Use the Reading Order tool to add or 
remove content from a region, or to split a region to reorder the content. 

SEE THE STEPS FOR ADDING OR REMOVING CONTENT FROM A TAGGED REGION. 
1. Select the Reading Order tool. 

2. In the Reading Order dialog, select Show Page Content Groups, and then 
select Page Content Order. 

3. In the document pane, select a highlighted region. 

4. Do one of the following: 

  

• To add content to the current selection, Shift-click the content you want to 
add. The pointer changes to include a plus sign (+). 

• To remove content from the current selection, Ctrl-select the content you 
want to remove. The pointer changes to include a minus sign (-). 

5. Select the button for the tag type that you want for the highlighted region. 

Split a region into two regions 
SEE THE STEPS FOR SPLITTING A REGION INTO TWO REGIONS. 

1. Select the Reading Order tool. 

2. In the Reading Order dialog, select Show Page Content Groups, and then 
select Page Content Order. 

3. In the document pane, drag to select a small portion of content near the boundary 

of the first region that you want to create. 

4. Select the Background/Artifact button in the dialog. The highlighted region splits 
into two regions, numbered from right to left. 

5. To correct the reading order, select Show Order Panel, and drag the new 
highlighted region to the correct location in the Order panel. 



6. Drag to select the first content region you created, including the 
background/artifact. Then set the tag by selecting a button in the Reading 
Order dialog. 

Apply a heading tag 

To help readers navigate a document and find the information they need, make sure that 
headings are tagged with the appropriate level to indicate their hierarchy in the content. 

SEE THE STEPS FOR APPLYING A HEADING TAG. 
1. Select the Reading Order tool, and then select the heading text in the PDF. 

2. In the Reading Order dialog, select the button corresponding to the appropriate 

heading tag (for example, Heading 1, Heading 2). 

  

Note:  

After applying heading tags, you can convert the headings to bookmarks to improve 
navigation. For more information, see Add tagged bookmarks. 

Remove page elements from the tag structure 

When tagging a PDF, Acrobat can’t always distinguish between instructive figures and 

decorative page elements. Items that visually enhance page layout, such as decorative 
borders, lines, or background elements, can add clutter to the structure layout and should be 

removed. Therefore, Acrobat may incorrectly tag artifacts or page elements as figure tags. 

You can remove artifacts and irrelevant page elements from the tag structure by redefining 

them with the Background/Artifact tag or by deleting their tags. If a tagged image in the 
document doesn’t contain useful or illustrative information for the user, you can remove the 
element from the tagging structure so that it isn’t read out loud or reflowed. 

SEE THE STEPS FOR REMOVING PAGE ELEMENTS FROM THE TAG STRUCTURE. 
1. Select the Reading Order tool. 

2. In the Reading Order dialog, select Show Page Content Groups, and select Page 
Content Order. Then, select Show Tables And Figures. 

3. Remove the page element by doing one of the following: 

  

• In the document pane, select the page element, and then 
select Background/Artifact in the dialog. 

• In the Order panel, select the page element, and then press Delete. 

https://helpx.adobe.com/acrobat/using/page-thumbnails-bookmarks-pdfs.html#add_tagged_bookmarks


Edit tags for figures and tables (Acrobat Pro) 

You can use the Reading Order tool to add and edit tags and alternate text for figures and 
tables. 

Apply a figure tag 

You can select an element and define it as a figure by using the Reading Order tool. Once you 
define it as a figure, you can add alternate text to describe the figure. 

SEE THE STEPS FOR APPLYING A FIGURE TAG. 
1. Using the Reading Order tool, select the figure. 

2. In the Reading Order dialog box, select Figure. 

3. In the document pane, open the context menu for the region, and choose Edit 
Alternate Text. 

4. Enter alternate text, and select OK. 

Check and correct figure tags 

You can use the Reading Order tool to identify and correct tagging results for figures. 

Determine whether figures include or require alternate text necessary to be read correctly 

with assistive technologies. Ideally, figure tags should identify image content that is 
meaningful to the document as a whole, such as graphs or illustrative photographs. If 

background/artifact elements that shouldn’t be read are tagged as figures, redefine them as 
background/artifact. 

SEE THE STEPS FOR CHECKING AND CORRECTING FIGURE TAGS. 
1. Select the Reading Order tool, and then select Show Tables And Figures in the 

dialog. 

2. Do any of the following: 

• If a figure isn’t tagged as a figure, select the content region you want, and 
then select Figure or Figure/Caption in the dialog. 

• To remove text that was incorrectly combined with a figure, drag to select 
the text, and select the Text/Paragraph button in the dialog. 

• To include a caption that is grouped with the figure, select the figure and 
caption, and select the Figure/Caption button in the dialog. 

Check and add alternate text for figures 



If you want screen readers to describe graphical elements that illustrate important concepts 
in a document, you must provide the description using alternate text. Figures aren’t 

recognized or read by a screen reader unless you add alternate text to the tag properties. If 
you apply alternate text to text elements, only the description, not the actual text, is read. 

SEE THE STEPS FOR CHECKING AND ADDING ALTERNATE TEXT FOR FIGURES. 
1. Select the Reading Order tool. 

2. Select Show Tables And Figures in the dialog. 

3. From the context menu of the figure, choose Edit Alternate Text. 

4. In the Edit Alternate Text dialog, type a new (or edit an existing) description for the 
figure, and then select OK. 

Edit table tags and tag unrecognized tables 

Tables pose a special challenge for screen readers because they present textual or numerical 

data to be easily referenced visually. Content within table cells can be complex and might 
contain lists, paragraphs, form fields, or another table. 

For best results when tagging tables, use the application that you created the document with 
to add tags when you create the PDF. If a PDF isn’t tagged, you can add tags by using the Add 

Tags To Document command. Most tables are properly recognized using this command; 

however, the command may not recognize a table that lacks clear borders, headings, 
columns, and rows. Use the Reading Order tool to determine if the table has been properly 

recognized and to correct recognition problems. To add specialized formatting to tables and 
table cells, use the Tags panel. 

You can use Table Editor to automatically analyze a table into its components and apply the 

appropriate tags. However, you must check and correct some of these tags manually. By 
viewing table tags, you can determine whether columns, rows, and cells have been correctly 

identified. Tables that lack well-defined borders and rules are often tagged incorrectly or 

contain adjacent page elements. You can correct poorly tagged tables by selecting and 
redefining them; you can split combined cells by creating a tag for each cell. 

To correct complex tagging problems for tables, you often must use the Tags panel. 

SEE THE STEPS FOR EDITING TABLE TAGS AND TAGGING UNRECOGNIZED 

TABLES 
1. Select the Reading Order tool, and then select Show Tables And Figures. 

2. If the table isn’t clearly labeled in the document pane, drag to select the entire 
table, and then select Table in the dialog. 

3. Select Show Table Cells to make sure that all cells in the table are defined as 
individual elements. 



4. If cells don’t appear as separate elements, do one of the following: 

  

• If one or more cells are merged, use the Reading Order tool to select the 

area within a single cell, and then click Cell in the dialog box. Repeat for 
each merged cell. 

• If cells aren’t highlighted, the table might not use standard table formatting. 
Re-create the table in the authoring application. 

5. If the table contains cells that are intended to span across two or more columns, set 
ColSpan and RowSpan attributes for these rows in the tag structure. 

Remove or replace document structure tags 

(Acrobat Pro) 

If adding tags to a PDF in Adobe Acrobat results in a tagging structure that is overly 

complicated or too problematic to fix, you can use the Reading Order tool to remove or 

replace the current structure. If the document contains mostly text, you can select a page and 
then remove headings, tables, and other elements to create a cleaner, simpler tagging 
structure. 

Acrobat can retag an already tagged document after you first remove all existing tags from 
the tree. 

Remove all tags from a PDF 
SEE THE STEPS FOR REMOVING ALL TAGS FROM A PDF. 

1. Select View > Show/Hide > Navigation Panels > Tags from the hamburger menu 
(File menu in macOS), and select the root (topmost) tag. 

2. In the Tags panel, select Delete Tag from the Options menu. 

Replace the existing tag structure 

This procedure works best in pages that contain a single column of text. If the page contains 
multiple columns, each column must be selected and tagged individually. 

SEE THE STEPS FOR REPLACING THE EXISTING TAG STRUCTURE. 

1. Select the tool. 

2. In the document pane, drag to select the entire page. The selection includes both 
text and nontext elements. 



3. Ctrl-drag around nontext page elements, such as figures and captions, to deselect 
them until only the text is selected on the page. Select Text/Paragraph in 
the Reading Order dialog. 

4. In the document pane, select a nontext page element, such as a figure and caption. 

Then select the appropriate button in the dialog to tag it. Repeat until all page 
content is tagged. 

 


